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Legal Information
The Schneider Electric brand and any trademarks of Schneider Electric SE and its
subsidiaries referred to in this guide are the property of Schneider Electric SE or its
subsidiaries. All other brands may be trademarks of their respective owners.

This guide and its content are protected under applicable copyright laws and furnished for
informational use only. No part of this guide may be reproduced or transmitted in any form or
by any means (electronic, mechanical, photocopying, recording, or otherwise), for any
purpose, without the prior written permission of Schneider Electric.

Schneider Electric does not grant any right or license for commercial use of the guide or its
content, except for a non-exclusive and personal license to consult it on an "as is" basis.
Schneider Electric products and equipment should be installed, operated, serviced, and
maintained only by qualified personnel.

As standards, specifications, and designs change from time to time, information contained in
this guide may be subject to change without notice.

To the extent permitted by applicable law, no responsibility or liability is assumed by
Schneider Electric and its subsidiaries for any errors or omissions in the informational
content of this material or consequences arising out of or resulting from the use of the
information contained herein.

As part of a group of responsible, inclusive companies, we are updating our communications
that contain non-inclusive terminology. Until we complete this process, however, our content
may still contain standardized industry terms that may be deemed inappropriate by our
customers.
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Safety Information

Safety Information

Important Information
Read these instructions carefully, and look at the equipment to become familiar with the
device before trying to install, operate, service, or maintain it. The following special
messages may appear throughout this documentation or on the equipment to warn of
potential hazards or to call attention to information that clarifies or simplifies a procedure.

The addition of this symbol to a “Danger” or “Warning” safety label indicates that an 
electrical hazard exists which will result in personal injury if the instructions are not 
followed.

This is the safety alert symbol. It is used to alert you to potential personal injury 
hazards. Obey all safety messages that follow this symbol to avoid possible injury or 
death.

DANGER indicates a hazardous situation which, if not avoided, will result in death or serious 
injury.

! DANGER

WARNING indicates a hazardous situation which, if not avoided, could result in death or 
serious injury.

WARNING!

CAUTION indicates a hazardous situation which, if not avoided, could result in minor or 
moderate injury.

CAUTION!

NOTICE is used to address practices not related to physical injury.

NOTICE
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Safety Information

Please Note
Electrical equipment should be installed, operated, serviced, and maintained only by
qualified personnel. No responsibility is assumed by Schneider Electric for any
consequences arising out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction and
operation of electrical equipment and its installation, and has received safety training to
recognize and avoid the hazards involved.

Before You Begin
Do not use this product on machinery lacking effective point-of-operation guarding. Lack of
effective point-of-operation guarding on a machine can result in serious injury to the
operator of that machine.

WARNING
UNGUARDED EQUIPMENT
• Do not use this software and related automation equipment on equipment which does

not have point-of-operation protection.
• Do not reach into machinery during operation.
Failure to follow these instructions can result in death, serious injury, or equipment
damage.

This automation equipment and related software is used to control a variety of industrial
processes. The type or model of automation equipment suitable for each application will
vary depending on factors such as the control function required, degree of protection
required, production methods, unusual conditions, government regulations, etc. In some
applications, more than one processor may be required, as when backup redundancy is
needed.

Only you, the user, machine builder or system integrator can be aware of all the conditions
and factors present during setup, operation, and maintenance of the machine and,
therefore, can determine the automation equipment and the related safeties and interlocks
which can be properly used. When selecting automation and control equipment and related
software for a particular application, you should refer to the applicable local and national
standards and regulations. The National Safety Council's Accident Prevention Manual
(nationally recognized in the United States of America) also provides much useful
information.

In some applications, such as packaging machinery, additional operator protection such as
point-of-operation guarding must be provided. This is necessary if the operator's hands and
other parts of the body are free to enter the pinch points or other hazardous areas and
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serious injury can occur. Software products alone cannot protect an operator from injury. For
this reason the software cannot be substituted for or take the place of point-of-operation
protection.

Ensure that appropriate safeties and mechanical/electrical interlocks related to point-of-
operation protection have been installed and are operational before placing the equipment
into service. All interlocks and safeties related to point-of-operation protection must be
coordinated with the related automation equipment and software programming.

NOTE: Coordination of safeties and mechanical/electrical interlocks for point-of-
operation protection is outside the scope of the Function Block Library, System User
Guide, or other implementation referenced in this documentation.

Start-up and Test
Before using electrical control and automation equipment for regular operation after
installation, the system should be given a start-up test by qualified personnel to verify
correct operation of the equipment. It is important that arrangements for such a check are
made and that enough time is allowed to perform complete and satisfactory testing.

WARNING
EQUIPMENT OPERATION HAZARD
• Verify that all installation and set up procedures have been completed.
• Before operational tests are performed, remove all blocks or other temporary holding

means used for shipment from all component devices.
• Remove tools, meters, and debris from equipment.
Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Follow all start-up tests recommended in the equipment documentation. Store all equipment
documentation for future references.

Software testing must be done in both simulated and real environments.

Verify that the completed system is free from all short circuits and temporary grounds that
are not installed according to local regulations (according to the National Electrical Code in
the U.S.A, for instance). If high-potential voltage testing is necessary, follow
recommendations in equipment documentation to prevent accidental equipment damage.

Before energizing equipment:
• Remove tools, meters, and debris from equipment.
• Close the equipment enclosure door.
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• Remove all temporary grounds from incoming power lines.
• Perform all start-up tests recommended by the manufacturer.

Operation and Adjustments
The following precautions are from the NEMA Standards Publication ICS 7.1-1995 (English
version prevails):

• Regardless of the care exercised in the design and manufacture of equipment or in the
selection and ratings of components, there are hazards that can be encountered if such
equipment is improperly operated.

• It is sometimes possible to misadjust the equipment and thus produce unsatisfactory or
unsafe operation. Always use the manufacturer’s instructions as a guide for functional
adjustments. Personnel who have access to these adjustments should be familiar with
the equipment manufacturer’s instructions and the machinery used with the electrical
equipment.

• Only those operational adjustments actually required by the operator should be
accessible to the operator. Access to other controls should be restricted to prevent
unauthorized changes in operating characteristics.
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About the Book

About the Book

Document Scope
This document describes the installation and update of Control Expert software. Installation
of the different tools (converter, communication drivers, ...) is explained in the different items
contained in the online-help documentation.

Validity Note
This documentation is valid for EcoStruxureTM Control Expert 15.1 or later.

Related Documents
Title of documentation Reference number

Schneider Electric License Manager, User Manual EIO0000001070 (English), EIO0000001071 (French),
EIO0000001072 (German), EIO0000001074
(Spanish), EIO0000001073 (Italian), EIO0000001075
(Chinese)

Schneider Electric Floating License Manager, User
Manual

EIO0000001078 (English), EIO0000001079 (French),
EIO0000001080 (German), EIO0000001082
(Spanish), EIO0000001081 (Italian), EIO0000001083
(Chinese)

EcoStruxure™ Control Expert, Security Editor,
Operation Guide

EIO0000004105 (English), EIO0000004106 (French),
EIO0000004107 (German), EIO0000004108 (Italian),
EIO0000004109 (Spanish), EIO0000004110
(Chinese)

EcoStruxure™ Control Expert, Topology Manager, User
Manual

EIO0000002756 (English), EIO0000004371 (French),
EIO0000004372 (German), EIO0000004370 (Italian),
EIO0000004369 (Spanish), EIO0000004373
(Chinese)

EcoStruxure™ Control Expert, Operating Modes 33003101 (English), 33003102 (French), 33003103
(German), 33003104 (Spanish), 33003696 (Italian),
33003697 (Chinese)

EcoStruxure™ Control Expert, Program Languages
and Structure, Reference Manual

35006144 (English), 35006145 (French), 35006146
(German), 35013361 (Italian), 35006147 (Spanish),
35013362 (Chinese)
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Title of documentation Reference number

EcoStruxure™ Control Expert, Control, Block Library 33002535 (English), 33002536 (French), 33002537
(German), 33003686 (Italian), 33002538 (Spanish),
33003687 (Chinese)

Communication Drivers, Installation Manual 35006152 (English), 35006153 (French), 35006154
(German), 35013950 (Italian), 35006155 (Spanish),
35012192 (Chinese)

You can download these technical publications, the present document and other technical
information from our website www.se.com/en/download/.
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General Information

General Information
This chapter describes the contents of the software packages, the main characteristics of
software installation, the system configuration requirements needed to execute Control
Expert software, and the recommended precautions when installing or updating Control
Expert.
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General Information

Presentation of Control Expert Software

Installation Media

Control Expert can be installed by using the DVD-ROM or .iso file downloaded from the
web.

Access Levels

Control Expert installs with two access levels:

Control Expert It includes the Topology Manager, which manages system projects. One or more
controllers (each with their own control project) and various devices constitute a
system project. The control projects can be managed by starting one or more
Control Expert editor instances within the Topology Manager.

Control Expert with Topology Manager is based on a client-server architecture,
page 13. Setup installs both a Control Expert system server service and the client
application on the computer.

The Control Expert repository constitutes the database, which is managed by the
system server and contains system project data.

NOTE: Refer to EcoStruxure™ Control Expert, Topology Manager, User
Manual for details on the interaction between a system project and control
projects.

Control Expert Classic It is the equivalent of Control Expert V15.0 and earlier versions. Each instance of
Control Expert Classic manages one control project at a time.

Languages

The following display languages are available for Control Expert:
• English
• French
• German
• Spanish
• Italian
• Chinese
NOTE:

To modify the language of Control Expert select Start > Programs > EcoStruxture
Control Expert > Language Selection.
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Recommended Control Expert Architectures

Schneider Electric recommends using either of the following architectures for Control Expert
(with Topology Manager):

• All-in-one architecture: Consists of one computer on which client instances are
started and connect locally to the system server (default configuration).

• Distributed architecture, which consists of:
◦ One computer that acts as system server.

(Client instances can also be started on this computer and connect locally to the
server.)

◦ One or more remote computers on which client instances are started and connect to
the system server.

NOTE: The maximum number of Control Expert client instances that you can open per
computer is 4.

Software Licenses

There is one Control Expert setup (.iso file) and the license determines the access level and
version that can be launched.

Access level to Control Expert according to the license is given in the following table.

Software License Control Expert (with
Topology Manager)

Control Expert Classic

Control Expert S No Yes

Control Expert L No Yes(1)

Control Expert XL No(2) Yes(1)

Control Expert XL with M580 Safety No(2) Yes

Control Expert XL with Topology Manager and M580
Safety

Yes Yes

(1) Adding the M580 Safety CPUs is possible with a M580 Safety Add-On license.

(2) Access to Control Expert with Topology Manager is possible with a Topology Manager Add-On license.

Two types of licenses are available to activate Control Expert:
• Node-locked license for use on a local PC. A node-locked license is used on the PC

where Control Expert is installed.
• Floating license for multiple uses of an authorized number of PCs in a network

connected to the Enterprise License Server.
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NOTE: To use remote desktop connection on Windows Server it is advised to use
floating license.

• Only one remote desktop connection is allowed with a node-locked license,
whatever the number of seats.

• With a floating license, several remote desktop connections are supported but
limited by the available usage rights.

Activation

Control Expert software comes with a 30-day trial license.

When the first installation is complete, the trial license is automatically activated during first
launch of the software product.

The trial license includes the maximum set of software product features which corresponds
to the Control Expert XL with Topology Manager and M580 Safety license.

At any time during the trial period or after the trial period you can activate your license.
NOTE: When a license is activated, the trial version is no more usable.

If you do not activate your license, Control Expert software no longer runs after the trial
period has expired.

Registration

You can register your Control Expert license at any time on the Schneider Electric Software
Licensing Web Portal.

NOTE: Registration is not mandatory and can be done even if the license has not yet
been activated.

The registration of the license on the Schneider Electric Software Licensing Web Portal
allows you to:

• View all your licenses and their status.
• Increase the number of authorized transfer of licenses between PCs.
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Recommended Precautions when Installing or Updating
Control Expert

Recommended Precautions before Installation

The following table shows the recommended precautions before installing or updating
Control Expert:

Step Action

1 Check the system requirements, page 16 of the workstation.

2 Check that the Windows session used to install or update Control Expert has administrator rights.

3 Perform a back-up, page 34 of all current applications and settings before updating Control Expert.

4 Check that the latest Windows Service Pack is installed.

5 Check that the latest Windows Security patches are installed.

6 Disable temporarily all the antivirus services (real time, scripting, etc.).

7 Check that the language required with Control Expert is available with Windows, for example, Chinese
language for the Windows operating system.

8 Close all running applications, (including the current version Control Expert when updating).
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Computer Configuration

Performance Considerations

The configuration of the computer determines the level of performance.

The performance of Control Expert can be affected by opening simultaneously several
windows, accessing a large quantity of animated data, or using a large application.

Hardware and System Requirements

For details on hardware and system requirements, refer to the readme file. It is available in
the ISO installation file and after installation at the path C:\Program Files (x86)\Schneider
Electric\Control Expert X (where X is the installed version).

NOTE: If you reinstall the operating system on computer where a license has been
activated, then the license information is no longer available. In this case, you can
reinstall the already activated license on the Enterprise License Server without
consuming additional usage rights.

Firewall

Control Expert with Topology Manager is based on a client-server architecture. The first time
Control Expert is installed on a PC, the service SE.Automation.SystemManager.
Service.exe is executed.

If a firewall is active on the operating system, make sure that this service execution is
authorized on the computer acting as Control Expert server. Otherwise, Control Expert
clients cannot connect to the server to engineer system projects.

Other Requirements

The following are required before installing Control Expert:
• Microsoft Edge
• Windows Installer V4.5 or later
• .NET 3.5 SP1 and .NET 4.8 (for details, refer to the readme file available in the ISO

installation file)

Control Expert on Windows Server 2019

On Windows Server 2019, Control Expert runs without restriction.
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Control Expert in a Virtual Machine

Control Expert runs on the following virtual machines:
• VMware Workstation Pro
• VMware vSphere - Hypervisor - ESXi

Before launching Control Expert on your virtual machine, make sure that the setting
Accelerate 3D graphics is not activated. Otherwise you may have a blank window and/or
unreadable messages.

To access the display settings of your Control Expert virtual machine, select Player >
Manage > Virtual Machine Settings.... In the Hardware tab, select Display.
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Installing Control Expert for the First Time

Overview
This chapter describes the first time installation of Control Expert software.

NOTE: In case Unity Pro is already installed on the computer, refer to the chapter
Updating Unity Pro with Control Expert, page 33 for specific operations to perform prior
and after Control Expert installation.
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How to Perform a First Installation of Control Expert

Introduction

The procedure for a first-time installation involves installing Control Expert without searching
for a Unity Pro or Control Expert version already installed on the computer.

User Rights

To install the Control Expert software, you must have the administrator privileges on the
workstation.

NOTE: Control Expert is always installed so that it is available for all the users of the
workstation. Refer to EcoStruxure™ Control Expert, Security Editor, Operation Guide, for
configuring user access rights.

Components Installed

The following Control Expert components are installed:
• Control Expert with Topology Manager: Allows managing several control projects within

one or more system projects.
• Control Expert Classic: Allows managing control projects only.
• PL7 convertor utility
• Concept convertor utility
• PLC Simulator
• OS Loader (an option is provided to download EcoStruxure Automation Device

Maintenance to replace it)
• Install libset: When required, this tool allows to install Libset versions that are not

available on your computer.
NOTE: Only the Libset V10.0 and later are automatically installed.

• All DTMs associated to controllers and modules available in Control Expert Hardware
Catalog Manager

• Schneider Electric Software Update
NOTE: During installation, enable Schneider Electric Software Update tool to check
for updates in order to benefit from Hotfix releases.

• Optional drivers
• License manager
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NOTE: Some equipment that is supported in the Control Expert Topology Manager and
available in the catalog may require the installation of additional software so that it can
be configured.

Default Directories

The default destination directory of the Control Expert software installation is: C:\Program
Files (x86)\Schneider Electric\Control Expert ••.•\

The custom libraries destination directory is set by default to: C:\ProgramData
\Schneider Electric\Control Expert ••.•\CustomLibset\V••.•

NOTE: The characters “••.•” are replaced by the installed version of Control Expert.

Installation Procedure

Execute the following steps to install Control Expert software.

Step Action

1 Make sure that your system meets the minimum configuration requirements, page 16 to install and run
Control Expert.

2 Make sure that you are connected as an administrator of the workstation.

3 The beginning of the installation procedure depends on the software package media.

With DVD-ROM: Insert the DVD-ROM named Control Expert. The software package setup is
automatically launched. If not, go to the DVD root and launch setup.exe.

With .iso file: Extract the files of the installation package to disk or mount the image (.iso). Double-click
the setup.exe file located in the root of the installation package.

Result: The installation procedure starts.

4 Select the language for the installation from the drop-down list and confirm by clicking OK.
NOTE: The selected language is used for the Control Expert installation and execution.

5 When Next is available, click it to confirm the Welcome screen.

6 After reading the compatibility information in the ReadMe and ReleaseNotes dialog, and other relevant
information, click Next to continue.

7 Read the software license, confirm that you agree by checking the “I accept the terms in the license
agreements” box, and click Next to continue.

8 You can choose an alternative path for the installation directory and the SESU (Schneider Electric
Software Update) tool and/or click Next to continue.

9 You can choose to install or not the communication drivers and click Next to continue.

10 Select the shortcuts needed and click Next to continue.
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Step Action

11 To begin the installation, click Install.

12 When the installation process is complete, you can select Open release notes and/or Start Control
Expert after quitting the installation by clicking Finish.

Installation Diagnostic Considerations

NOTE: For Chinese installation, the installation path must not contain Chinese
characters.

To configure the installation directory manually, follow this procedure.

Step Action

1 Right-click My Computer > Properties.

3 Select the Advanced tab.

4 Click Environment Variables button.

5 Add a new path in the User Variables.
NOTE: The path by default when Control Expert is installed is: C:\Program Files (x86)
\Schneider Electric\Control Expert ••.•\.
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Automatic Installation

At a Glance

Automatic installation of Control Expert requires no action during the installation. The
installation performed is the same as a default installation in the manual mode. It is carried
out with the provided install.bat batch command file. This file is at the root of the
Control Expert DVD-ROM or in the installation package (.iso file).

To be able to perform an automatic installation:
• Manually update the install.bat file in a text editor.
• Launch the automatic installation process by executing the personalized install.bat

file.
NOTE:

If you use the automatic mode to uninstall Control Expert and have used the Topology
Manager, no message is shown in case one or more system projects are not upward
compatible. Although the system projects are exported, page 59, you will not be able to
reuse those that are not upward compatible in the next version of Control Expert.

If the system server is not available, page 46, system projects cannot be exported. In
such case, the installation is canceled and an event is logged in the Windows Event
Viewer.

For details on the upward compatibility, refer to the topic describing properties of system
projects (see EcoStruxure™ Control Expert, Installation Manual).

Modifying the Command File

The following table describes the procedure for modifying the command file and launching
the automatic installation:

Step Action

1 Select the file install.bat from the Control Expert installation DVD-ROM or from the extracted
files of the installation package (.iso file).

2 Right-click to display the contextual menu and select Edit.

Result: The file opens in text format.

3 Fill in the parameters.

The install.bat file is self-documented. It contains an up-to-date description and possible
parameter values.
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Step Action

4 Save the file.

5 Double-click on the modified file.

Result: The installation starts and windows appear during the progress of the installation process.
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How to Activate a Node-locked License

Overview

The node-locked license needs to be activated within 30 days after software installation.

The license is activated on the local PC where Control Expert is already installed:

NOTE: At https://www.youtube.com/watch?v=0bSzFztSt7k you can find a video
explaining how to activate a Node-locked license.

Required Information

Required to activate a license, you receive the Activation ID either:
• Printed and sent in an envelope, or
• Sent via email.
Activation ID example:

Node-locked License Activation Procedure

This procedure describes the steps for activating a node-locked license on the computer
where Control Expert is already installed:
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Step Action

1 Start License Manager tool.

2 Select Activate.

3
The following window appears:

NOTE: If your computer has no Internet connection, or is not connected to the Schneider Electric
License Server you can activate by mobile device, by web portal, or by phone. For detailed
information, refer to Schneider Electric License Manager, User Manual or License Manager on-line
help.

4 Prompt your Activation ID and click Next.

After few seconds, the successfully created license message appears

5 Click Finish

Control Expert is now activated on the computer.

6 Close License Manager tool.
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How to Activate a Floating License

Overview

The floating license is activated on the Enterprise License Server:

NOTE: At https://www.youtube.com/watch?v=jvQBbFYtOg0 you can find a video
explaining how to activate a floating license.

Required Information

Required to activate a floating license, you receive the Activation ID either:
• Printed and sent in an envelope, or
• Sent via email.
Activation ID example:
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Floating License Activation Procedure

This procedure describes the steps for activating a floating license on the Enterprise License
Server:

Step Action

1 Start Floating License Manager tool.
NOTE: If not already installed on the Enterprise License Server, the Floating License Manager
installation package is available in Control Expert installation package (.iso) in the
FloatingLicenseManager folder.

2 Select Activate.

3
The following window appears:

NOTE: If your computer has no Internet connection, or is not connected to the Schneider Electric
License Server you can activate by web portal. For detailed information, refer to Schneider Electric
Floating License Manager, User Manual or Floating License Manager on-line help.

4 Prompt your Activation ID, set Usage Rights and click Next.

After few seconds, the successfully created license message appears

5 Click Finish

The floating license is now activated on the Enterprise License Server.

6 Close Floating License Manager tool.
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Floating License Usage

Once activated, the floating license can be used from any computer connected to the same
network as the Enterprise License Server.

When used on a computer, the floating license is checked out from the Enterprise License
Server and is not available for any other connected computer from this moment. After usage
the floating license is checked in again and is available for other connected computers
again.

NOTE: The license can be taken offline from Enterprise License Server to a computer. It
then behaves as a node-locked license, and the computer can be disconnected from the
Enterprise License Server network.
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Connecting to the Enterprise License Server

Step Action

1 Start License Manager tool.

2 Select the Floating tab.

3
The following window appears:

Select your Enterprise License Server in the Selected License Server drop list and click Show.
NOTE: If the connection to the Enterprise License Server is not yet configured, click Configure.
For detailed information on Enterprise License Server configuration procedure, refer to Schneider
Electric License Manager, User Manual or License Manager on-line help.

Taking Offline a Floating License

Step Action

1 In the Floating tab of the License Manager tool, select your Enterprise License Server.

2 Click Show.

Result: An Internet browser opens with the web portal of the FLEXnet License Administrator.
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Step Action

3 In the FLEXnet License Administrator click Activatable to display the available floating licenses.

From the list copy, the name and the version of the product to be taken offline.

4 Go back to the Floating tab of the License Manager and enter name and version (separated by a
blank) in the text box for requested information.

5 Enter Duration (Days) form 1 day to unlimited (1 000 000).
NOTE: Duration is the time period you want to take offline the license from the Enterprise License
Server to your local PC. It is recommended to keep the duration short to avoid in case of damage or
loss of your local PC that this license will be blocked for usage to other users till the duration
expires.

6 Click Take offline.

Result: The license is added to the list of Licenses currently took offline.

7 After time period expires, the license is automatically returned to the Enterprise License Server.

If you want to return the license back to the Enterprise License Server before the end of the time period
set above:

1. Go back to the Floating tab of the License Manager.
2. In the list of Licenses currently took offline select the license you want to return.
3. Click Return.
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Control Expert License Registration

Overview

Registration is done on Schneider Electric Software Licensing Web Portal (SLP).

The SLP is a cloud-based service of Schneider Electric that provides universal access to
your Schneider Electric Software licenses on the web. The SLP allows you to overview and
manage your licenses and registrations.

NOTE: before registering a license, you have to create your Schneider Electric Web
User Account if not already done.

When licences are registered, the number of return, repair, and reinstall is extended:

Actions Single

(1 seat)

Group

(3 seats)

Team

(10 seat)s

Entity

(100 seats)

Return 1 → 7 2 → 9 5 → 20 25 → 150

Repair 1 → 3 2 → 5 3 → 10 8 → 50

Reinstall 1 → 3 2 → 5 3 → 10 8 → 50

NOTE: At https://www.youtube.com/watch?v=0bSzFztSt7k you can find a video
explaining how to register your licenses.

Creating your Schneider Electric Web User Account

Step Action

1

Go to www.se.com\licensing, or click on the globe icon on the License Manager / Floating
License Manager tool.

2 Select Create new Schneider Electric Web User Account.

3 Enter your email address that will be your user ID for your Schneider Electric Web User Account.

Fill in the mandatory fields and validate.
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Registering a License

Step Action

1 Login to the Schneider Electric Software Licensing Web Portal (SLP).

2 Select Register license into my account.

3 Enter the Activation ID for your license and click Register.
NOTE: If your license is yet registered, a message will inform you.
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Updating Unity Pro With Control Expert

Subject of this Chapter
This chapter describes how to update a Unity Pro version with Control Expert.

It explains how to perform a back-up of the user applications, settings, custom libraries,
private ASI Catalog and also deals with the recommendations related to previous versions
of Unity Pro.
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Operations Required Prior to an Update of Unity Pro with
Control Expert

Overview

Before updating Unity Pro with Control Expert, it is recommended that the current project
files be saved.

If the previous installed version is earlier than Unity Pro 4.0, the following items must also be
saved:

• Custom libraries
• Private ASI catalog

In addition, refer to specific updates, page 37 for older versions of Unity Pro.
NOTE: If the version currently installed on the workstation is incomplete for any reason,
it must be uninstalled before updating. Then, the new version of Control Expert must be
installed using the first time installation procedure, page 19.

Export Current Project Files

This step consists of generating files that are used to migrate projects to Control Expert
(Classic). Export current projects from the project file format (*.STU) into an archive
application file format (*.STA). It is also recommended to export into an application
exchange file format (*.XEF).

The file types are:
• *.STU files from previous versions of Unity Pro are not readable on the new version of

Control Expert.
• *.STA files are archive files compatible between different versions of Control Expert and

Unity Pro. However, these files can only be created for projects that can be successfully
built. The advantage of this format is the capability to connect to the PLC after opening
the project on a newer version of Control Expert.

• *.XEF files are used for exporting a global project without global DTMs configuration
and are compatible with all versions of Control Expert or Unity Pro. Importing an *.XEF
file requires a Rebuild All of the project.

• *.ZEF files are used for exporting projects with global DTMs configuration and are
compatible with all versions of Control Expert or Unity Pro. Importing an *.ZEF file
requires a Rebuild All of the project

For additional information about file formats, refer to:
• Service in Offline Mode (see EcoStruxure™ Control Expert, Operating Modes)
• Users Applications and Projects File Formats (see EcoStruxure™ Control Expert,

Program Languages and Structure, Reference Manual)
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For additional information about project compatibilities with Unity Pro versions and PLC
firmware, refer to Start > Programs > Schneider Electric > SoCollaborative > Unity Pro
> ReleaseNotes.

For additional information about using projects with Control Expert with Topology Manager,
refer to Importing Control Projects (see EcoStruxure™ Control Expert, Topology Manager
User Manual).

Create Archived Application File (*.STA)

The following table describes the procedure for generating *.STA files:

Step Action

1 Launch the current Unity Pro software:

Start > Programs > Schneider Electric > SoCollaborative > Unity Pro > Unity Pro xx (xx refers
to Unity Pro package).

2 Open the project (*.STU file):
• File > Open.
• Select the project (*.STU file).
• Click Open.

3 File > Save Archive, see note below.

4 Choose a location for the file to be saved. Do not save files in the default Schneider Electric directory:

C:\Program Files\Schneider Electric\Unity Pro or C:\Program Files (x86)
\Schneider Electric\Unity Pro

Files saved in this directory may be deleted during Control Expert installation.

5 Click Save.

6 Remember the location where the *.STA file is stored on the terminal as it is needed when recovering
the project.

NOTE: The Save Archive function is only available if:
• The project has been generated.
• The Tools > Project Settings > General > PLC embedded data > Upload

information, option is selected and at least Comments or Animation tables is
selected.

Create Application Exchange File (*.XEF or *.ZEF)

The following table describes the procedure for generating *.XEF or *.ZEF files:
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Step Action

1 Launch the current Unity Pro software:

Start > Programs > Schneider Electric > SoCollaborative > Unity Pro > Unity Pro xx (xx refers
to Unity Pro package).

2 Open the project (*.STU file):
• File > Open.
• Select the project (*.STU file).
• Click Open.

3 File > Export Project.

4 Choose a location for the file to be saved. Do not save files in the default Schneider Electric directory:

C:\Program Files\Schneider Electric\Unity Pro or C:\Program Files (x86)
\Schneider Electric\Unity Pro

Files saved in this directory may be deleted during Control Expert installation.

5 Click Export and select the export file format (*.ZEF or *.XEF).

6 Remember the location where the *.ZEF or *.XEF file is stored on the workstation as it is needed when
recovering the project.

Save Custom Libraries

Save custom libraries and families as follows:

Step Action

1 Launch the current Unity Pro software:

Start > Programs > Schneider Electric > SoCollaborative > Unity Pro > Unity Pro xx (xx refers
to Unity Pro package).

2 Tools > Types Library Manager.

3 Select 1 custom family.

4 Right-click the selected custom family.

5 Click Create an installable family.

6 Choose a location for the installable family to be saved.

7 If sub-types need to be included, select Include sub-types check box.

8 Click OK.

Do not save files in the default Schneider Electric directory:

C:\Program Files\Schneider Electric\Unity Pro or C:\Program Files (x86)
\Schneider Electric\Unity Pro
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Step Action

Files saved in this directory will be deleted during Control Expert installation.

9 Save other custom libraries by repeating steps 3 to 8.

10 Exit the Types Library Manager by clicking Close in the Types Library Manager dialog.

After the storage location is defined and the settings saved, several DSC files containing the
custom library settings will be created.

For more information, refer to Types Library Manager (see EcoStruxure™ Control Expert,
Operating Modes).

Save the Private ASI Catalog

If a private ASI catalog is used, copy the following files to another directory where they can
be recuperated later:

• ...\Schneider Electric\ConfCatalog\Database\Asi \1031\private.ctg, private2.ctg
• ...\Schneider Electric\ConfCatalog\Database\Asi \1033\private.ctg, private2.ctg
• ...\Schneider Electric\ConfCatalog\Database\Asi \1034\private.ctg, private2.ctg
• ...\Schneider Electric\ConfCatalog\Database\Asi \1036\private.ctg, private2.ctg
• ...\Schneider Electric\ConfCatalog\Database\Asi \1040\private.ctg, private2.ctg
• ...\Schneider Electric\ConfCatalog\Database\Asi \2052\private.ctg, private2.ctg
NOTE: Do not save files in the default Schneider Electric directory: C:\Program Files
\Schneider Electric\Unity Pro or C:\Program Files (x86)\Schneider
Electric\Unity Pro. Files saved in this directory will be deleted during Control
Expert installation.

Specific Update Considerations

The following are specific update considerations related to older versions of Unity Pro:
• For Unity Pro V5.0:

The Installer of DTM library cannot completely manage uninstallation of the previous
DTMs installed with Unity Pro V5.0. This may lead to incorrect installation of the DTMs
(especially the Generic DTMs).
Uninstall previous versions of the LOKI and Generic DTMs (using the Windows add or
remove Programs function) before installation of Control Expert.

• For Unity Pro versions earlier than Unity Pro 3.0:
For projects that were built with an earlier version than Unity Pro 3.0, packing the PLC
memory in RUN on Premium may lead to stop the PLC. In order to avoid this behavior,
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after opening the STA archive file, perform a Rebuild All of the project. Rebuilding the
project involves a STOP of the PLC as well as a full download of the project.
For more information, refer to Service in Offline Mode (see EcoStruxure™ Control
Expert, Operating Modes).

• For Unity Pro versions earlier than Unity Pro 2.0:
As the pin layout for the elementary function block COM_DB was changed with Unity
Pro 2.0, applications containing this EF and designed with an earlier version need to be
exported and imported. Moreover, new variables must be assigned on the inputs and
outputs of the EF.
For more information, refer to COMP_DB: Comparison (see EcoStruxure™ Control
Expert, Control, Block Library).
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Updating Unity Pro with Control Expert

Procedure

As Control Expert licenses are not compatible with Unity Pro licenses, updating Unity Pro on
a workstation with Control Expert is very similar to the first time installation procedure, page
18.
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Restoring Projects and Settings After Control Expert
Installation

Overview

After the installation of Control Expert is completed, projects and settings can be recovered
by restoring in the following recommended order:

Only if the previous installed version is less than Unity Pro 4.0:
• Custom libraries
• Private ASI catalog

For all versions, including versions less than Unity Pro 4.0:
• DFBs and DDTs in the Type Library Manager
• Archived Application *.STA and/or Application Exchange Files *.XEF (Control Expert

Classic)
NOTE: The Libset V10.0 and later are automatically installed with Control Expert. If
required to install previous Libset versions, start Programs > EcoStruxure Control
Expert > Install libset tool.

Restoring Custom Libraries

To restore custom libraries, import them using the Type Library Update tool.

The procedure is explained below:

Step Action

1 Close Control Expert if it is open.

2 Start Programs > EcoStruxure Control Expert > Types Library Update.

3 In the Types Library Update dialog:
• Enter the directory of the custom family previously stored, page 36 on the workstation (DSC file

type).
• Select the version of the libset where the custom family needs to be installed.

4 Click Install family.

5 The following message may appear:

The installation has succeeded but there are warnings. Details are in file: <C:\WINNT\logunit\install.
log>

Disregard this message. Click OK.

6 Repeat steps 3 to 5 for each custom family that needs to be restored.
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Step Action

7 Launch Control Expert:

Start > Programs > EcoStruxure Control Expert > Control Expert.

8 Check that all the families have been successfully installed:

Tools > Types Library Manager > <Libset> > Custom Lib.

For more information, refer to Types Library Manager (see EcoStruxure™ Control Expert,
Operating Modes).

Restoring Manually DFBs, DDTs, and FFBs in the Type Library Manager

It is possible to restore the custom libraries manually even if they have not been saved.

This operation is useful in the following cases:
• You forgot to save custom libraries in an installable form, page 36 before updating,
• You have been using custom FFBs defined with EFB Toolkit.

The directory of the custom libraries depends on Unity Pro version installed and the
operating system. Generally, they are saved automatically during the installation process in
the following directory:

• Unity Pro 4.0 or later:
◦ Windows 7 or 10 (32 bits or 64 bits): C:\ProgramData\Schneider Electric

\Unity Pro\CustomLibset\Vx.y

◦ Windows XP: C:\Program Files\Schneider Electric\Application Data
\Schneider Electric\Unity Pro\CustomLibset\Vx.y

• Unity Pro 3.1 or earlier:
C:\Program Files\Schneider Electric\Application Data\Schneider
Electric\Unity Pro\CustomLibset\OldCustomdbxx.yy

The following table shows how to proceed when replacing Unity Pro 3.1 or earlier:

Step Action

1 Copy the content of the old custom library from the following directory (example):

C:\Program Files\Schneider Electric\Application Data\Schneider Electric\Unity
Pro\CustomLibset\Vx.y

2 Paste the content of the old custom library into the newer Control Expert custom library directory:

C:\ProgramData\Schneider Electric\Control Expert ••.•\CustomLibset\Vx.y, where
••.• is the installed Control Expert version.

3 Repeat step 1 and 2 for all versions Vx.y where the custom library is needed.
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NOTE: x.y or xx.yy are the version number of the former Unity Pro and Control Expert
versions.

Restoring Private ASI Catalog

If the private ASI catalog files were previously saved, they must be restored to their original
location, page 37.

Restoring Archived Application File (*.STA)

This restoration consists of importing the *.STA files previously stored, page 34. The *.STA
files are used when the PLC cannot be stopped. To restore *.STA files follow the procedure
below for each project:

Step Action

1 Launch Control Expert:

Start > Programs > EcoStruxure Control Expert > Control Expert.

2 Open the *.STA file from File > Open menu.

The file type selected must be Unity Pro Archived Application File (*.STA).

3 Click Open.

4 Save the project as an *.STU file.

Restoring Application Exchange File (*.XEF)

This restoration consists of importing the *.XEF files previously stored, page 34. Importing
from an XEF format involves to re-generate the project. To restore *.XEF files follow the
procedure below for each project:

Step Action

1 Launch Control Expert:

Start > Programs > EcoStruxure Control Expert > Control Expert.

2 Open the *.XEF file from File > Open menu.

The file type selected must be Unity Pro Application Exchange File (*.XEF).

3 Click Open.

4 Save the project as an *.STU file.
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Operations Common to Control Expert
Installation and Update

Subject of this Chapter
This chapter describes procedures that are common to Control Expert first time installation
and update.
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Updating Control Expert

Description

An update of Control Expert corresponds to the installation of a new version of Control
Expert by keeping the same package, for example, updating from Control Expert V14.0 L to
V15.0 L.

It consists in:
• The installation of the new software version. This is similar to a first installation, page

19,
• The activation of an update license:
◦ In case of a major release update (for example, updating Control Expert from V14.1

to V15.0) a new license activation is required.
◦ In case of minor release update (for example, updating Control Expert from V14.0 to

V14.1), a license activation is not required. License of the previous version is still
valid.
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Upgrading Control Expert

Description

An upgrade of Control Expert corresponds to the activation of another package license. For
example, upgrading from Control Expert V15.0 L to Control Expert V15.0 XL.
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How to Start Control Expert

Overview

Control Expert installs with two access levels:
• Control Expert (with Topology Manager).
• Control Expert Classic

How to Start a Control Expert Instance

To start Control Expert with Topology Manager execute the command:

Start > Programs > EcoStruxure Control Expert > Control Expert.

Independently of the access security that is configured in the Security Editor of the computer
acting as Control Expert server, you need to enter in the log-in window the username of a
user that has been created and enabled in the centralized security database. If a password
is set for this user, you must enter it.

The functionality that you can use depends on the rights of the user whose username you
have entered. For more information, refer to EcoStruxure™ Control Expert, Security Editor,
Operation Guide.

By default, Control Expert (client) instances that you open connect to the local Control
Expert server whose address and port is localhost:19950.

To connect to a remote Control Expert server, page 13, configure the listening IP address of
the server, page 49. Then, enter its IP address in the Networks and Server section of the
User Preferences window (see EcoStruxure™ Control Expert Topology Manager, User
Guide). The window opens by clicking its icon in the Topology Manager toolbar.

NOTE: The system server service is configured to start automatically. If you experience
difficulties connecting to the system server, verify that the SE.Automation.System
Manager.exe process is running on the computer that is used as system server.
NOTE:

If you have yet to activate the software, a message alerts you of the remaining number
of days of use left and whether the activation can still be completed.

The Topology Manager is available only with specific software licenses, page 13.
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How to Start a Control Expert Classic Instance

To start Control Expert Classic, execute the command:

Start > Programs > EcoStruxure Control Expert > Control Expert Classic.

You need to enter in the log-in window, the username and password of a user that has been
created and enabled in the centralized security database if access security is set to either
policy in the Security Editor:

• Security on, mandatory login
• Security on, avoidable login

For more information, refer to EcoStruxure™ Control Expert, Security Editor, Operation
Guide.

NOTE: If you have yet to activate the software, a message alerts you of the remaining
number of days of use left and whether the activation can still be completed.

License Selection for Control Expert Classic

The first time you start Control Expert Classic after activating a valid license, page 13, you
have to select the package corresponding to your license in the Package Selector tool.

NOTE: If you have multiple valid licenses on your computer, the Package Selector tool
selects by default the highest package (XL > L > S).

The Package Selector tool differentiates the package (S, L or XL) as shared base and
M580 safety is not mentioned. So, if XL with M580 Safety or XL with Topology Manager and
M580 Safety is installed, select the XL package.

M580 safety CPUs are included in the following licenses:
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• Control Expert XL with M580 SAFETY
• Control Expert XL with Topology Manager and M580 SAFETY
• M580 Safety Add-On for Control Expert L or XL licenses.

In both cases, selecting the corresponding Control Expert package (L or XL) opens the
software with M580 safety CPUs.

How to Change the Language of Control Expert

To change the language of Control Expert Classic and Control Expert with Topology
Manager, proceed as follows.

Step Action

1 Execute the command Start > Programs > EcoStruxure Control Expert > Language
selection.

Result: The Control Expert Language Selection dialog is displayed.

2 Select the language for Control Expert.

3 Confirm with OK.

Result: A message tells you that the language selection is effective the next time you start Control
Expert Classic or Control Expert.
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Enabling Communication with Remote Clients and
Reinforcing Security

Overview

This topic describes the steps that you need to perform on the computer acting as Control
Expert server when you want to connect a remote Control Expert client.

NOTE: Schneider Electric strongly recommends strengthening communication security
between the system server and the client.

Configuring the Listening IPAddress by Using the Server Configuration Tool

To manage and restrict client access to the Control Expert server, proceed as follows:

Step Action

1 Run as administrator the Server Configuration tool on the computer acting as Control Expert
server by executing the following command:

Start > Programs > EcoStruxure Control Expert > Server Configuration.

2 In the Listening Connections section, select the Listening IP address value from the list and
click Apply:

• 127.0.0.1 (Local connection): The server does not allow connections from remote Control
Expert clients. (Default value)

• 0.0.0.0 (All connections): The server allows connections from any Control Expert client.
• Network adapters of the system server computer: The server only allows connections

from Control Expert clients that are on the same network as the adapter.
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Strengthening Communication Security

The following procedure applicable to Windows Defender is provided as example only. Your
operating system and application may have different requirements or procedures.

To set-up a communication with improved security, proceed as follows:

Step Action

1 Open Windows Defender Firewall with Advanced Security (wf.msc) using the Microsoft
Management Console (mmc.exe).

2 Click Inbound Rules in the left pane. In the Action pane, click New rule….

Result: The New Inbound Rule Wizard opens.

3 In the New Inbound Rule Wizard:
• In the step Rule Type select Custom and click Next.
• The step Program opens. Select This program path:, set C:\Program Files (x86)

\Schneider Electric\Control Expert X\Server\SE.Automation.
SystemManager.exe (where X is the version that is installed) and click Next.

• The step Protocols and Ports opens:
◦ Set Protocol Type to TCP,
◦ Set Local Port to Specific Ports, and enter 19950-19952 to port range.
◦ Click Next.

• The step Scope opens. Leave the settings as they are and click Next.
• The step Action opens. Select Allow the connection if it is secure and click Next.
• The step Users opens. Leave the settings as they are and click Next.
• The step Computers opens. For Authorized computers select Only allow connections from

these computers and add authorized computer names. Click Next.
• The step Profile opens. Select Domain, clear Private, and clear Public. Click Next.
• The step Name opens. In the Name box enter SystemManager, and in the Description box

enter TCP rules. Click Finish.

4 In the Inbound Rules pane select then, copy and paste the SystemManager rule.

5 Select the pasted SystemManager rule and click Properties.
• In the General tab, change the description from TCP rules to UDP rules.
• In the Protocols and Ports tab:
◦ Set Protocols Type to UDP,
◦ Set Local Port to Specific Ports and enter 19950 as port range.

Click OK to close the Properties window.

6 Close the Microsoft Management Console.
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How to Repair Control Expert

Objective

This feature allows to completely repair an existing Control Expert distribution if the current
installation is damaged.

Control Expert repair method is only performed through installation Setup (from DVD-ROM
or .iso file). Any other method may not work.

NOTE: Corrupted DTM installations cannot be repaired. They must be uninstalled using
the Windows remove programs function and then reinstalled.

Control Expert Repair Procedure

The following table describes the procedure to repair Control Expert from the Control Expert
Setup on the DVD-ROM or .iso file in the maintenance mode:

Step Action

1 The beginning of the repair procedure depends on the software package media.

With DVD-ROM: Insert the DVD-ROM named Control Expert. The software package setup is
automatically launched. If not, go to the DVD root and launch Setup.exe.

With .iso file: Extract the files of the installation package to disk or mount the image (.iso).
Double-click the Setup.exe file located in the root of the installation package.

2 The installation wizard for Control Expert starts. Click Next.

3 The Program Maintenance window opens. Select the Repair option and confirm by clicking
Next.

4 Launch the procedure by clicking Install.

NOTE: Repair Control Expert procedure does not install Libset files. To update Libset
files, it is necessary to use Install libset tool.
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How to Transfer a License

License Transfer Procedure

In order to transfer a Control Expert license to another user:

Step Action

1 Return the license from the computer and send it back to the Schneider Electric License Server.

Result: The license is available for activation on another computer.

2 Activate the license, page 24 on the other computer.

License Return Procedure

This procedure describes the steps for returning a node-locked license:

Step Action

1 Start License Manager tool.

2 On the Local tab, select the Activation ID of the license you want to return.

3 Select Return.

After few seconds, the successfully removed license message appears

4 Click Finish

You cannot any more start Control Expert on the computer.

5 Close License Manager tool.
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Floating License Return Procedure

This procedure describes the steps for returning a floating license:

Step Action

1 Start Floating License Manager tool on the Enterprise License Server.

2 On the Local tab, select the Activation ID of the license you want to return.

3 Select Return.

After few seconds, the successfully removed license message appears

4 Click Finish

You cannot any more start Control Expert on the computers connected to Entreprise License Server.

5 Close Floating License Manager tool.
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How to Repair a License

Introduction

A license can become untrusted, for example due to replacement of hardware components
of a PC or Enterprise License Server.

License Repair Procedure

This procedure describes the steps for repairing a node-locked license:

Step Action

1 start License Manager tool.

2 On the Local tab, select the Activation ID of the license you want to repair.

3 Click the Repair button.

Result: The Repair in Progress dialog opens.

In the text box information about the internal processing of license repair is displayed.
NOTE: If your computer has no Internet connection, or is not connected to the Schneider Electric
License Server you can repair by mobile device, by web portal, or by phone. For detailed
information, refer to Schneider Electric License Manager, User Manual or License Manager on-line
help.

4 After the license is successfully repaired, click the Finish button.

Result: The repaired license is displayed in the list of licenses as active in the Local tab.

5 Close License Manager tool.

Floating License Repair Procedure

This procedure describes the steps for repairing a floating license:

Step Action

1 Start Floating License Manager tool on the Enterprise License Server.

2 On the Local tab, select the Activation ID of the license you want to return.

3 Click the Repair button.

Result: The Repair in Progress dialog opens.

In the text box information about the internal processing of license repair is displayed.
NOTE: If your computer has no Internet connection, or is not connected to the Schneider Electric
License Server you can repair by web portal. For detailed information, refer to Schneider Electric
Floating License Manager, User Manual or Floating License Manager on-line help.
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Step Action

4 After the license is successfully repaired, click the Finish button.

Result: The repaired license is displayed in the list of licenses as active in the Local tab.

5 Close Floating License Manager tool.
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Drivers

At a Glance

During installation of Control Expert, three drivers can be optionally installed:
• Uni-Telway
• Modbus
• USB

If selected, the three drivers are installed. One driver cannot be installed without the others
being installed.

These drivers provide the link between the workstation and the PLC. The driver to be used
is selected in Control Expert.

Normally, it is not necessary to change the configuration of the installed drivers. In
exceptional cases use the Drivers Manager to reconfigure a driver or install a new drivers
from Communication Drivers directory on the Control Expert DVD-ROM.

For information about drivers installations and configurations, refer to the SetupDrv.pdf in
your language in the Communication Drivers directory.

Launching the Drivers Manager

To launch the Drivers Manager execute the command:

Start > Programs > EcoStruxure Control Expert > Drivers Manager.
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Increasing Number of Control Expert Editors Open

Introduction

After a standard installation use of multiple instances of Control Expert only allows a limited
number of editors that can be open at the same time: 15 open editors for the first instance
and 6 open for the remaining instances.

Removing Editor Limits

By modifying a Windows registry parameter with the following procedure, the number open
editors can be increased:

1. Run the registry editor (%SystemRoot%\WINDOWS\regedit.exe).
NOTE: %SystemRoot% is normally the “C:” drive.

2. Find the registry key:
HKEY_LOCAL_MACHINE\ System\CurrentControlSet\Control\Session Manager
\SubSystems\Windows.

3. Right-click Windows and select Edit String.
4. Find the parameter SharedSection=xxxx,yyyy,zzzz. SharedSection is the first

parameter and it is placed nearly at the beginning of the data content.
5. Set the yyyy value (in kB) to 8192 (if it was set to a lower value). It controls the size of

the desktop heap, which is used for Windows objects.
6. Restart the workstation to have the updated value taken into account.
NOTE: After changing the SharedSection value the only limit on the number of open
editors is the amount of RAM installed on the workstation.
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Uninstalling Control Expert

Subject of this Chapter
This chapter describes when it is necessary to uninstall Control Expert. It also explains how
to proceed when uninstalling.

58 35014793.15



Uninstalling Control Expert

How to Uninstall Control Expert

Objective

This operation is used to delete all Control Expert software components from the
workstation.

However, this does not affect:
• Application files.
• System projects (Topology Manager). They are automatically exported to the Migration

folder at the path %ProgramData%\Schneider Electric\ControlExpert.Topology X
(where X is the installed version) on the computer acting as system server.

• Database backup files (Server Configuration tool).
• Control Expert execution rights (Activation IDs are managed with Schneider Electric

License Manager).
• Elements shared with other software packages (for example, Control Expert user).

When Uninstalling Control Expert Is Required

Control Expert must be uninstalled manually when installing:
• An earlier version of Control Expert, for example, installing Control Expert 14.1 on

Control Expert 15.0.
• A version of Unity Pro.

NOTE: Installing a version of Unity Pro or an earlier version of Control Expert can
lead to incompatibility with other software, for example, OFS, UDE and UAG.

Before Uninstalling Control Expert

• For Control Expert with Topology Manager, ensure that the Supports Upward
Compatibility attribute of your system projects is selected; otherwise, they are not
compatible anymore with the next version of the software.

• For Control Expert activated with a node-locked license, it is recommended to return the
license, page 52 before uninstalling Control Expert in order to install it onto another
workstation.

NOTE: When uninstalling Control Expert, the Schneider Electric License Manager
tool might be also deleted if it is not required by any other software.
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Uninstalling Control Expert by Using the Setup File

The following table describes the procedure to uninstall Control Expert from the Control
Expert Setup on the DVD-ROM or .iso file in the maintenance mode:

Step Action

1 The beginning of the uninstall procedure depends on the software package media.

With DVD-ROM: Insert the DVD-ROM named Control Expert. The software package setup is
automatically launched. If not, go to the DVD root and launch Setup.exe.

With .iso file: Extract the files of the installation package to disk or mount the image (.iso). Double-
click the Setup.exe file located in the root of the installation package.

2 The installation wizard for Control Expert starts. Click Next.

3 The Program Maintenance window opens. Select the Uninstall option and confirm by clicking Next.

4 Launch the procedure by clicking Remove.

Uninstalling Control Expert by Using the Windows Control Panel

The following table shows how to uninstall Control Expert manually with the Windows
control panel:

Step Action

1 Start > Control Panel > Programs and Features.

2 Right-click Control Expert and select Remove.

3 A pop-up window appears asking for confirmation. Click Yes.

After Uninstalling Control Expert

Uninstalling Control Expert from the Windows Control Panel or Setup.exe file does not
remove the DTM Library. As a result, installation of an earlier version of Control Expert /
Unity Pro (with earlier version of DTM Library) will not succeed.

In this case uninstall manually the following DTM libraries:
• EcoStruxure Control Expert PSx DTM Library
• Schneider Electric Placeholder DTM Library
• Schneider Electric Mx80 HART Gateway DTM Library
• Schneider Electric BME NOR DTM Library
• Schneider Electric PME DTM Library
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• CXM DTM
NOTE: When the uninstallation of Control Expert and the DTM Library is completed you
may have to proceed in the same manner to uninstall drivers and other DTMs that you
have manually installed for Control Expert.

Replacing Control Expert with an Earlier Version

To install an earlier version of Control Expert / Unity Pro, the current version of Control
Expert must be uninstalled using the Windows control panel as previously described.

In addition, the following directories must be manually removed if not used by another
Schneider Electric software:

• C:\Program Files (x86)\Common Files\Schneider Electric Shared\Tlb

• C:\Program Files (x86)\Common Files\Schneider Electric Shared
\Common

• C:\Program Files (x86)\Common Files\Schneider Electric Shared
\SRCSDK

• C:\Program Files (x86)\Common Files\Schneider Electric Shared\SSTA
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